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| Office 2000: Configuring Office I

Introduction
*  There are usually several ways to accomplish the same task in any software
package. This guide will provide information on short-cuts and helpful tips that
may be used in most Office products (Word, Excel, PowerPoint, and Access). In a
few instances where a short-cut or hint doesn’t apply, it will be noted accordingly.

Overview of Configuring Office
* You can configure certain options in Office that will take effect across the entire
Office suite. For example, you can change the menu settings so that all menu
items are visible within a pull-down menu.
*  Other configuration changes, such as customizing the toolbars or specifying a
default folder for documents, effect only the application where the change is made.

Display and Configure the Office Toolbar
*  The Office toolbar provides short-cut buttons to many Office functions and to
other applications.
e The toolbar may also be configured according to your needs.

Example of the Office Toolbar
(with short-cut buttons to Word, Excel, PowerPoint, etc.)

B office EEENEIEELIEE-EE =]

e Method:
1. Click the Start button.
2. From the cascading menus, select: Programs/Microsoft Office Tools/
Microsoft Office Shortcut Bar.
3.  Ifdesired, move the toolbar to another location on your screen.
4.  If desired, configure your toolbar to add or remove short-cut buttons for a
task or application. To do so...
a. Right-click in an empty space on the Office toolbar.
b. From the short-cut menu, select: Customize.
c. Click on the tab for Buttons.

Example of the Customize Dialog Box for Buttons
21x|

Wigw  Buttons | Toolbarsl Settingsl

Toolbar:

Add File. .. |
Show these Files as Butkons:

[ ] Mew Task - ml

[ E=INew cortact j ll Ade Space |

O [:QNEW Journal Entry

O Nx.aw Mote — Delete |
Mlcrosoft Word

Microsoft Excel ﬂ Rename. .. |
S| Microsoft PowerPaint

Microsoft Access

[ Flmicrasoft Einder LI

()8 I Cancel |
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| Office 2000: Configuring Office I

d. Add or remove checkmarks to choose to either display or not display a
button for a task or application.

e. Use the Up and Down buttons to rearrange the order of the buttons as
they appear on the toolbar.

f. Click OK.

Change the Default Folder for Saved Documents
* By default, documents are stored in a folder called My Documents. You may
change the default location to another folder where you wish to save your files.

e Method:
D ’t k in: S .
EX::;S nPP¥ OZCCI;ISS 1. From an Office application menu, select: Tools/Options.
(See note below.) 2. Click on the tab for File Locations.

3. Inthe Files Type section, click on Documents.

Example of the Options Dialog Box for File Locations
2|

Wigw IGeneraII Edit I Print I Save ISpeIIing&Grammarl

Track Changes I Idser Information I Cornpatibility

File bypes: Location:

Documents E: 10y Documents

Clipatt pickures

User templates L AMicrosoft Templates
‘Workgroup bennplates

User opkions

AutoRecover Files C:..\application DakalMicrosoft,.
Taoals E:\Micrasaft Officetoffice
Skartup L AMicrosoft ward\ S TARTUR

=
Madify. .. |

oK I Close I

4.  Click the Modify button.

5. Navigate to the drive and folder where you wish to save your files. (Or,
create a new folder.) Click OK.

6.  Click OK.

* Note: You can configure a default folder in PowerPoint and Access. However, it
is done slightly different. From either of these applications, select Tools/Options
from the menu. In PowerPoint, click on the tab for Save, or in Access, click on the
tab for General. In the appropriate box, type the complete path name for the
default folder.
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| Office 2000: Configuring Office I

Display All Items within a Pull-down Menu

* By default, Office only shows a portion of the items that are available via a pull-
down menu. This type of menu is often referred to as an adaptive menu.

Example of the Edit Menu

(where only some of the menu items are displayed)
Edit
@Qﬂpy 931 s 1
@ Copy as HTML
(& Paste Clrl+

Select &l Cirla

b
L

Method to view all menu items for an adaptive menu:
1.  Click on a menu and then do one of the following:

a. Move your mouse pointer over the double-pointed arrow at the bottom
of the menu.

OR

b. Wait several seconds (and the remaining menu items will be
displayed).
OR

c. Use the method below to display all of the menu items every time you
open a menu.

Method to change the default menu configuration so that all menu items display
every time you open a menu in any Office application:

1 From an Office application menu, select: Tools/Customize.
Click on the tab for Options.

2.
3. Remove the checkmark from: Menus show recently used commands first.
4. Click the Close button.

Configure the Standard or Formatting Toolbars

* You may add buttons to or delete buttons from the standard and formatting
toolbars.

Standard Toolbar
JEiIe Edit ¥iew Insert Format Tools Table Window Help
[JD@HIH%B.W pEPR S o-o @

—> JNDrmaI + Times Mew Roman » 11 = H; I u HEE

~ N2 3.

B =2
===

Formatting Toolbar
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| Office 2000: Configuring Office I

e Method to add a button to a toolbar:
1. From an Office application menu, select: Tools/Customize.
2. Click on the tab for Commands.

Example of the Customize Dialog Box to Add Buttons
x|

Toolbars ~ Commands | Qptions I

Categories; Commands;

File - Insert Takble... -
Edit D

Yiew [ge) Insert Excel Spreadsheet

Insert =

Farmat E«: Cells, .,

Tools =]

=% Rows

Web P Colurins ko the Left

Window and Help

Dirawing LI g Delste Cells ;I

Selected command:
Description I IMadify Selection T |

Ell Save in: INurmaI.dot 'l geybuard...l Close I

3.  Inthe Categories section, click on the category that contains the command
(i.e. button) that you want to add to a toolbar.
¥ To find the desired button, you may have to look through several
categories and then scroll through the associated Commands
section of the dialog box.
4.  Inthe Commands section, click on the button and drag it to the desired
location on the toolbar.
¥ When you drag a button to the toolbar, notice that the mouse
pointer changes to an [-beam pointer. The I-beam indicates where
the button will be placed on the toolbar.
5. Click the Close button.

*  Method to remove a button from the toolbar:
1. Hold down the Alt key, click on the button, and drag it off the toolbar.
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| Office 2000: Menu Short-cuts I

Overview
* There are a variety of ways to access menus in most applications. For instance,
you can:

0 display a menu using the keyboard
execute a command from an open menu
display the short-cut menu for an object
use the keyboard short-cut for a menu item
display the short-cut key in ScreenTips

O o0oOo0o

Display a Menu Using the Keyboard
* Each menu name contains a letter that is underlined. (For example, notice that the
Table menu name has the letter “a” underlined.) The underlined letter is used for
the keyboard short-cut.

e Method:
1.  Hold down the ALT key and press the letter that is underlined in a menu
name.

Example of a Menu Bar
(notice the underlined character for each menu name)
‘ Eile Edit Yiew [nsert Format Tools Table Window Help ‘

Execute a Command from an Open Menu
¢ Each menu item name contains a character that is underlined. The underlined
character is used for the keyboard short-cut.

*  Method:
1. Click on a menu name.
2. Type the character that is underlined for that command.

Example of an Open Menu
(notice the underlined character for each menu item name)

Wy il
MeEwy Wincow

arrange All
Split

IT 1 Documents
2 shortouts. doc
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Office 2000: Menu Short-cuts

Display the Short-cut Menu for an Object

* Almost all objects within a file (such as text, an image, etc.) have a short-cut menu.
This short-cut menu lists all or some of the frequently used menu items that may be
applied to that object.

*  Method:

1. Right-mouse click on an object (such as text, an image, etc.).
2. Select the desired item from the menu.

Example of a Short-cut Menu for an Image

& Cut
Copy
B Paste

Edit Picture
Hide Picture Toolbar

Borders and Shading...
Caption...

B Format Picture..,

W&, Hyperlink...
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| Office 2000: Menu Short-cuts I

Use the Keyboard Short-cut for a Menu Item
*  Many of the menu items have keyboard short-cuts.
*  Method:
1. First, find out if a menu item has a keyboard short-cut. To do so, click on
the menu name.
¥ The keyboard short-cut is listed to the right of the menu item name.
%  For example, the keyboard short-cut for Copy is Ctrl+C. (The plus
sign between the Ctrl key and the letter C indicates that you are to
press these keys at the same time.)

Example of the Edit Menu

(notice the keyboard short-cuts for some menu items)
Edit

¥ Unda Clear Cir+2

() Repeat Copy  Crly

3 Cut Clrl+x

Copy Cirl

5@ Copy as HTIML

BB, Paste CHr|+
Paste Special...

Paste as Hyperlink

Clear Del

Select All Chrl+a
@& Find... Cirl+F

Replace. .. Cirl+H

Go To... Ch+G

[Lirks. ..

Dhject

2. Click outside the menu to close it.
3. Then edit your document using the keyboard short-cut.
% Once you know the keyboard short-cut, you don’t need to do the
first two steps.
¥ In some cases, you may need to select the text first before using the
short-cut key (as when you perform a copy).
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| Office 2000: Menu Short-cuts I

Display Short-cut Key in ScreenTips
*  When you move your mouse over a toolbar button, a yellow rectangular box is
displayed which contains the name of the button.
*  You can customize the ScreenTip so that it also displays the keyboard short-cut.

Example of a ScreenTip with Short-cut Keys
uls=s==s|

Linderline {CtrI+U}|

Doesn’t work in: *  Method to change the default configuration so that the short-cut key is displayed

Excdl with the Screentip in any Office application:

1.  From an Office application menu, select: Tools/Customize.

2. Click the tab for Options.

3. A checkmark should appear in the box next to: Show ScreenTips on
Toolbars. Ifnot, then click in the box to add a checkmark.

4.  Click in the box next to: Show Shortcut Keys in ScreenTips to add a
checkmark.

5. Click the Close button.
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| Office 2000: Working with Files I

Overview
*  There are ways in which to quickly find, preview, retrieve, view, and delete files
within an application. It is also possible to open multiple documents and switch
between them and to increase or decrease the on-screen view of a document.

Open a Recently Used Document
* Each Office application keeps track of the most recent files that you opened. This
provides easy access to frequently used files.

e Method:
1. From the menu, select: File.
% The last four files that you opened are listed near the bottom of the
File menu.

Example of Recently Used Document List

Eile

O mew... CHrl+nN

= Open... Cir+o
Close

H save Cir+s

Save As...
Save as Web Page...
WErsions. ..

\ieb Page Preview
Export To »

Page Setup...

[&, Print Preview

b print... Cirl+p
Create Adobe FDF...
Create Adobe FDF...

Send To »
Properties

1 E:, . AOfficed\shortcuts.doc
2 B\ hasg-computer-mar01.doc

k a Afrontpage-article.doc
4 B Astudent-guide-2001. doc

Exit

2. Click on the name of the file that you wish to open.

*  You can also change the default setting for the number of files that are shown in
the recently opened file list.
*  Method to change the default setting for the number of recently opened files:
1. From an Office application menu, select: Tools/Options.
2. Click on the tab for General.
3. A checkmark should appear in the box next to: Recently Used File List. If
not, then click in the box to add a checkmark.

4.  In the Entries box, select a number from one to nine that represents the
number of files you want listed at the bottom of the File menu.
5. Click OK.
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| Office 2000: Working with Files I

Preview a Document Before Opening

* Sometimes it may be convenient to preview the contents of a file to decide if that’s
the one you actually want to open.

Doesn’t work in: e Method:
Excel, Access 1. From the menu, select: File/Open.

2. At the Open dialog box, click the drop-down arrow next to the Views icon.

Views Icon
in the Open Dialog Box

2|
Look in: I[:I Mermos j = | @ b O ~ Tools »

3. From the Views menu, click on Preview.
4. Use the Look In box to navigate to the desired drive and directory.
5. Click on a file name to see a preview of its contents.

Example of the Open Dialog Box with File Preview

x|
Look in: I[:I Memos j I | @ *» o5 ~ Tools ~
m-confirmseminar-FO0.doc| THE PENNSYLVANIA STATE ﬂ
B m-confir mseminar-S00.doc UNIVERSITY
B m-confirmseminar-S01.doc Inter-office Correspondence
ITi-pEL-SE minars, doc
rr-psu-serminars-FO0.doc
@ m-psLu-seminars-S00.doc
W rm-sermFO0.doc Date:  Awvgust 22, 2000
B rm-sermFO0-bak.doc
B m-semso0.doc From:  Carolyn Dudas
B rn-sems01.doc
B m-sems01-hak.doc To: Consultants
Re: Semunar Scheduling
[ have created a seminar schedule for |
File name: I j = Open vI
Files of type:  [all Fies (*.%) | Cancel |

6.  Click the Open button to open the file.
¥ If you would like to turn the preview mode off, select File/Open
from the menu. Click the drop-down arrow next to the Views
icon. From the Views menu, click on List.

Find a File Using a Simple Character String Search

* By default, when you use File/Open to retrieve a file, a list of all files for that
application is displayed. There may be times, however, when you wish to view
only those files that contain a specific string of characters. This may make it easier
to find a specific file rather than visually scanning through a long list of all files.

* There is also another way to do more complex searches for files. See the next
topic, Search for a File, for more information.
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| Office 2000: Working with Files I

Doesn’t work in: e  Method:

el 1. From the menu, select: File/Open.

2. At the Open dialog box, use the Look In box to navigate to the desired drive
and directory.

Example of the Open Dialog Box with a List of Files
x|

Look in: I[:l Memos j - |® b i ~ Tools «

My Documents

B rm-confir meeminar-FOD.doc
B m-confir meeminar-FO1.doc
B m-confir meeminar-500.doc
B m-confir meeminar-S01.doc
@ m-psu-seminars.doc

@ m-psu-seminars-FO0.doc
@ m-psu-seminars-S00.doc
W rm-sermF00.doc

B rm-sermF00-hak.doc

B rm-sermF01.doc

B mrsemso0.doc

E;] m-sermS01.doc

1

Size | Type =

59 KB Microsoft Wio
41 KB Microsoft Wio
58 KB Microsoft Wio
45 KB Microsoft Wio
43 KB Microsoft Wio
35 KB Microsoft vwo
22 KB Microsoft Wio
22 KB Microsoft Wio
34 KB Microsoft Wio
33 KB Microsoft Wio
35 KB Microsoft Wio
4 KB Text Docume |
37 KB Microsoft Wio
31 KB Microsoft Wo >
»

File name: I j

Files of bype: IAII Files {*.*) =

= Open 'I
Cancel |

3. Click in the File Name box.
4.  Type an asterisk, a string of characters (that you want to search for in the
file names), and an asterisk.
5. Press the Enter key.
¥ A list of files that match the character string are displayed.

Open

Look in:

@

My Documents

Example of a Character String Search
(to find file names with two consecutive zeroes)

I [:l Memos

21|

j "|®X@vho|§v

Hame

Size | Type

m-confirmserminar-FO0.doc|
m-confirmserminar-S00.doc
m-psu-seminars-FO0.doc

B m-psu-serminars-S00.doc
m-sernF00.doc
m-sernF00-bak.doc
m-serms00.doc

[

l

41 KB Microsoft Wor,.,
45 KB Microsoft Wor,.,
22 KB Microsoft Wor,.,
22 KB Microsoft Wor,.,
34 KB Microsoft Wor,.,
33 KB Microsoft Wor,.,
37 KB Microsoft Wor,.,

| i

[ Open |~

Cancel |

File name: I*DD* j

Files of bype: IAII Files (*,*) =

6.  Double-click on the file you wish to open.
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Search for a File
* Although it may not seem readily apparent, Office does provide a method for file
searches.
*  Method:
1. From the menu, select: File/Open.
2. At the Open dialog box, click on the Tools menu.

Tools Menu
in the Open Dialog Box
2|
Lok in: I[:I Memos j = | @ X ~ Tools +

3. From the Tools menu, select: Find.

4. At the Find dialog box, define the criteria to find the file. See the hint
below for an example.

Example of the Find Dialog Box
Jrind x|

rFind files that match these criteria

Files of type is &ll Files {*.*),

[~
[~ Match all word forms Delete | Mew Search |
[~ Match exactly
rDefine more criteria
Add ko Lisk |
& and Property: Condition: Value:
Cor IFiIe narme j Iincludes j ||
Loak in: IE:'II ;I ™ Search subfolders
Eind Mows I Cancel | Sawe Search. .. | Open Search. .. |

% Example: Find all files that have an extension of .ppt on the E:\
drive. To do so,
= Type: . ppt inthe Value Box.
= Use the default settings for the following items: Operator =
And, Property = File Name, and Condition = Includes.
5. Click the Add to List button. (The search criteria are now listed in the large
white box at the top of the dialog box.)
6.  Use the Look In box to navigate to the desired drive where you want to do
the search.
% To search multiple drives, use a semicolon to separate each drive
name. Example: C:\;D:\
¥ To search a specific directory, type the complete path name in the
Look In box. Example: E:\MyDocuments\Seminars
7. If you want to search any subdirectories, click in the box next to Search
Subfolders.
8. Click the Find Now button.
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Delete a File
e It’s not obvious (or intuitive) on how to delete a file from within an Office
application.
e  Method:

1. From the menu, select: File/Open.

Use the Look In box to navigate to the desired drive and directory.
Right click on the file you wish to delete.

From the short-cut menu, click on Delete.

Click the Cancel button to exit the Open dialog box.

N wDn

Switch Between Opened Documents
* Ifyou have two or more files opened within an application, you can easily switch
from one file to another. You can use either the menu or the Taskbar to switch
between files.
*  Method using the menu:
1. Open at least two files within the same application.
2. From the menu, select: Window.
¥ A list of the opened files within that application appears in the
lower portion of the Window menu.
% The currently active file has a checkmark next to its file name.
3. Click on the file name you wish to switch to.

Example of the Window Menu with Two Opened Documents
| Wil
Iy Wil cr

arrange All
Split

|T 1 magazine.doc

2 shortouts,doc

*  Method using the Taskbar:

1. Open at least two files within the same application.
2. Inthe Taskbar, click on the button that corresponds to the file you want to
view.

Example of the Taskbar
(notice that there are two Word documents opened)

E Startl | & @ 5K & || BRI I@ shortcuts.d... ™ magazine.do. . |
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Zoom In and Out
* You can view a document so that it appears larger or smaller on the screen. (This
does not affect the file size of your document nor does it change the size of the
fonts.)
*  Method using a Microsoft IntelliMouse (which has a scroll wheel located between

the left and right mouse buttons):
1.  Hold down the Ctrl key and rotate the scroll wheel to zoom in or out of a

document.
¥ 1If you don’t have an IntelliMouse, use the Zoom button on the

toolbar to change the viewing size.

Doesn’t work in:
Access

Example of the Zoom Button on the Standard Toolbar

10%

Page Width
Text Width
Whole Page
Twio Pages
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Overview
*  There are a number of short-cuts for selecting, editing, and formatting text.

Select Text
* There are a variety of ways for selecting text.
Method to select ALL text:

Doesn’t work in:
PPT 1 Press Ctrl+A.

D ET Ak A Method to select a BLOCK of text:
Excel, Access 1. Click in the location where you want to begin selecting the text.
2. Press Ctrl+Shift and use an arrow key to select the text.
% This method is helpful when it’s difficult to use the mouse for text
selections (because the document scrolls too fast on the screen).

Doesn’t work in: Method to select text to END of line:
Excel 1. Click in the location where you want to begin selecting the text.
2. Press Shift+End.

*  Method to select text to BEGINNING of line:
1. Click in the location where you want to begin selecting the text.
2. Press Shift+Home.

Doesn’t work in:
Excel

Apply Bold, Italic, or Underline to Text
* Boldfacing, italicizing, and underlining are frequently used to format text.
*  Method:
1. Select the desired text.
2. Do any of the following:
a. To apply boldfacing, press Ctrl+B.
b. To apply italic, press Ctrl+I.
c. To apply an underline, press Ctrl+U.

Cut, Copy, or Paste Text
*  Cut, copy, and paste are frequently used to edit documents.
*  Method to CUT text:
1. Select the text.
2. Press Ctrl+X.

e Method to COPY text:
1. Select the text.
2. Press Ctrl+C.

*  Method to PASTE text:
1. Click in the location where you want to paste the text.
2. Press Ctrl+V.
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Cut, Copy, and Paste Multiple Items
*  There may be times when you would like to cut or copy multiple selections of text
or other objects and paste them in another location within your document. This
can be done using the enhanced clipboard.

*  Method:
1.  From the menu, select: View/Toolbars/Clipboard to activate the enhanced
clipboard.

¥ The enhanced clipboard toolbar may also be docked in a fixed
location (like any other toolbar).
2. Cut or copy an object (such as text, an image, etc.).
Repeat the above step as needed.
¥ Up to 12 objects can be held in the enhanced clipboard.
% When you cut or copy the 13™ object to the enhanced clipboard,
the first item in the clipboard will be discarded and the newest
item will be added at the end.

W

Example of the Enhanced Clipboard
( 7 items are currently being held)

Rliphuard (7 of 12)

%z B Paste all B8 «———— Clear Clipboard

B EEE)
LA

4. Click at the location where you want to paste an item.
5. From the enhanced clipboard window, do one of the following:
a. Click the Paste All button to paste all of the items from the enhanced
clipboard.
OR
b. Click the icon that represents the object you want to paste.
% As you move the mouse pointer over the icon, a ScreenTip
identifies the object. (Graphic objects are only identified with a
descriptive label of: Item 1, Item 2, etc.)
6.  Ifdesired, click the Clear Clipboard button to clear all of the objects from
the enhanced clipboard.
¥ There is no way to clear individual items from the enhanced
clipboard.
7. Click the Close button to close the enhanced clipboard window.

*  The enhanced clipboard can be very useful, although it can get in the way.
Unfortunately, you can’t turn it off by the usual methods, such as using the menu.
e  Method to turn off the enhanced clipboard:
1. Close the enhanced clipboard three times consecutively.
¥ Do not cut, copy, or paste using the enhanced clipboard or use any
of the clipboard’s toolbar buttons. Otherwise, it will become
reactivated.
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Doesn’t work in:
Access

Doesn’t work in:
Access

Apply Formatting Multiple Times to Text
*  There may be times when you want to take the format of certain text and apply it to
other text within the document.

*  Method:

1. Select the text (or the cell in Excel) that already has the desired character or
paragraph format.
% Character formatting refers to the font, font size, boldfacing, etc.
Paragraph formatting refers to alignment, indents, line spacing, etc.

2. Click the Format Painter button on the Standard toolbar.

¥ The Format Painter button looks like this:
3. Use the mouse to select the text to which you would like to apply the
formatting.
4.  Click outside the selected text to see the formatting change.

*  You can also apply the same format to several different areas within the document:
*  Method:
1. Select the text (or the cell in Excel) that already has the desired character or
paragraph format.
2. Double-click the Format Painter button.
3. Use the mouse to select the text to which you would like to apply the
formatting. Repeat this step as many times as needed.
4, When done, click the Format Painter button to turn it off.
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| Office 2000: Working with Images I

Overview
* Two common tasks involving images are moving them to a specific location and
resizing them.

Tweak the Placement of Images
*  Most Office applications align an image to an invisible grid. Although this is
helpful, there are times when you want more precise control of the image’s
placement.
e Method:
1. Click the graphic to select it.
% In Word, an image may be formatted as free-floating or as in-line.
A free-floating image may be moved anywhere within a document.
An in-line image has the characteristics of text (and moves just
like text). An in-line image cannot be repositioned using this
method unless you convert it to a free-floating image by doing the
following:
a. Double-click the image.
b. At the Format Picture dialog box, click the tab for Layout.
c. Change the wrapping style from In-line with Text to any
other wrapping style.
d. Click OK.
2. Hold down the Ctrl key and use the arrow keys to move the graphic up,
down, right, or left.

Resize an Image Proportionally
* Animage may be resized so that its proportions are maintained.
e Method:
1. Click on the image to select it.
2. Move the mouse pointer over one of the corners (so that the mouse pointer
changes to a double-pointed arrow).
3. While holding down the Shift key, drag the mouse pointer to resize the
image.

Doesn’t work in:
Access
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| Office 2000: Notes I
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